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Enter. In the pedagogical process, along with the development of students' 

lexical competences, the development of their oral speech, their written speech is 

of great importance based on the norms of the literary language. 

The main part. In order to develop students' lexical competence based on 

the requirements set in the curriculum, one of the main tasks is to develop their 

knowledge and skills, such as speaking, listening, listening comprehension, and 

reading comprehension. "It should be noted that students can use it consciously in 

their speech only if they understand the meaning of each sentence and word." One 

of the primary goals in developing students' lexical competence is to work on the 

word and its dictionary meaning. Students can consciously use words in their 

speech only if they know the words well. A detailed understanding of the linguistic 

rules of the language allows students to choose words specific to the text of speech 

styles. Completing the educational tasks listed in the methodological supplies and 

analyzing them in cooperation will be the basis for understanding each other's 

opinions. 

Also, the improvement of the level of the students' oral speech development 

indicator is manifested in the free analysis of the scientific, poetic, artistic text and 

the independent thinking of the content of the text. Also, if they are able to read a 

scientific text and retell it orally, from the point of view of being able to express 

their thoughts and relationships, their written speech and literacy will increase. 

According to S. Salimova, writing thoughts and information without mistakes, i.e. 

"spelling is a sign of literacy, and literacy is a sign of culture." Spelling literacy of 

students is one of the types of written work, which is related to a number of tasks 

performed by them. These are the following: 

- acquiring the culture of reading and regularly reading various scientific and 

artistic books; 
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- "Explanatory dictionary of the Uzbek language", "Spelling dictionary of 

the Uzbek language", developing the skills of working with the dictionary of types 

of words according to the relationship of form and meaning; 

Learning to effectively use the lexical wealth and wise words of the Uzbek 

people in their speech; 

- working with tasks that develop thinking 

- read the recommendations of experts on working on mistakes and 

shortcomings made in the creation of a text and pay attention to the development 

of practical skills; 

In addition, the students should behave as a culture, act intelligently, be 

humble, write their thoughts correctly following the orthographic rules, avoid 

typical, spelling, and stylistic errors. it is assumed that it will not allow. At this 

point, the opinion of Methodist scientist K. Mavlonova is important. "One of the 

main factors of teaching students to think creatively is to provide them with the 

necessary knowledge that encourages them to think, express their opinions, and 

draw logical conclusions. For this, it is necessary to try to direct each lesson to the 

formation of students' creative thinking skills. It is necessary to give such 

knowledge and skills that as a result, the student can independently compose 

sentences, texts, write essays, statements, and freely interpret pictures and visual 

films. Exercises in the course of the lesson teach students to make a correct speech, 

speak fluently, write accurately, and express their opinion. Work on vocabulary 

types is effective in eliminating errors and shortcomings, such as hesitations in 

writing some words, inability to independently fill official texts without looking at 

samples, not knowing the spelling of certain speech sounds. Linguists H. 

Jamolkhanov and K. Sapayev in the study guide entitled "Problems of Imli" 

interpret the solution to this problem as the change of writing, while O'Usmonova 

points to dialects as the reason. It is necessary to teach the dialect speakers of a 

certain region to follow the standards of the literary language. We can see an 

indicator of growth in the ability to follow the norms of literary language in 

spelling literacy. In particular, it is appropriate to say the words that have entered 

our vocabulary in syllables. "At the time of copying, attention is paid to the sound-

letter composition of words. But there are recommendations in scientific sources 

that the importance of syllabic writing in improving spelling literacy is huge. 

Because new words to our language such as briefing, diversification, 

modernization, if the students work on these words and learn their dictionary 

meaning perfectly, the skills of practical application in live speech will be 

strengthened. 

 It is also important for students to learn the semantics of lexical units, so 

that they always know how to pronounce phonetic units correctly. "Phonetic units 

(sound, syllable, stress, intonation) it is noted that a certain relationship should be 

established between phonological units (phoneme, syllable, accenteme, 

intotoneme). Accurate pronunciation of speech sounds and adherence to stress and 

intonation during speech is an important function for intelligible hearing of words. 
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"Learning vocabulary means building more lexical skills. Accordingly, the 

formation of lexical skills consists of three stages: 

1.Introducing, discovering the meaning of a new word and re-pronouncing. 

2. Practicing and strengthening the use in speech situations. 

3. Stage with a changing situation" . 

"The process of learning a word is to understand what it means; remember 

the word; covers the ability to use words correctly in different situations of 

communication." The essence of the scientists' thoughts is to follow the meaning of 

the word, the rules of orthography, to memorize lexical units and to put it into 

action. Pupils acquire knowledge, skills and abilities about the meaning, essence, 

spelling of words. 

Using the information listened to, theoretical information, the students can 

find a suitable word instead of dots, it shows their thinking and ingenuity. 

It helps to develop, and creating a text with the participation of these words 

serves to develop their speaking skills. Therefore, the sentences in the text should 

be connected. "The text is the largest unit of the language with structural, 

meaningful and communicative integrity, which is formed in oral and written form 

based on the connection of the sequence of sentences." A text consisting of any 

sentence content is not connected speech. Selection of words related to a topic, 

coherent expression of ideas, content relatedness of paragraphs, compliance of 

morphological indicators and punctuation marks with literary language standards 

are the requirements of connected speech. One of the main tasks in order to 

determine the correct structure of connected speech is to perform an exercise 

orally, to analyze the sentences he has composed. While performing this task, it is 

advisable to perform exercises and tasks and organize interesting games so that he 

can eliminate the mistakes he made during the construction of connected speech. 

Summary. As a result of the reader's expressive reading,careful reading of 

texts,colorites, which represent the subject matter of the text, the meaning-essence 

of the sentences contained in the text, are comprehensively understood, and their 

spelling literacy increases. 
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Abstract: This article describes the use of macros in the Visual Basic for 

Applications (VBA) programming language in Microsoft Office applications, as 

well as commands that automate the work that the user can do in the VBA 

programming language. One of the opportunities that cannot be achieved with the 

standard tools of Office applications is the possibility of interactive testing in 

PowerPoint presentations. 
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The use of macros in the Visual Basic for Applications (VBA) programming 

language in the applications of the Microsoft Office software package is a separate, 

unique topic in the study of computer science. On the one hand, macro-

programming in VBA creates many possibilities that cannot be achieved with the 

standard tools of office applications, for example, when using a keyboard, 

converting characters when typing a Russian text in Latin case in Word, and 

conducting interactive tests in Excel or PowerPoint presentations. In MS Access, a 

macro is a sequence of actions. They are stored in a window reminiscent of a table 

so that they are stored in the order in which they should be executed. These actions 

are executed when the MS Access macro is run. Macros make using Access much 

easier. Macros are useful for binding buttons on forms. Operations can be 

performed using these buttons. Macros can be used to create custom add-ons and 

dialog boxes. 

However, on the other hand, it is very difficult to study this topic. That's 

why this topic is often avoided in educational literature (or, at least, is limited to 
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describing how to perform simple entries in macros as a sequence of user actions 

with menus, buttons and other elements of the interface). At the same time, it is 

very difficult to find macro-programming literature, so very few users know how 

to use such a convenient and universal mechanism for completing the functionality 

of office applications. 

Macro programming in VBA can be one of the important subjects of 

computer science in educational institutions, as well as a continuation of the 

subject of programming in Visual Basic. Also, while VBA is a bit unique, Visual 

Basic programming can serve as an always-on environment for learning purposes 

(and custom programming environments can be purchased and installed 

separately). will need to be installed). 

The following practical tasks of different levels allow to work independently 

(but under the guidance of the teacher) during the lessons, the main issues of using 

macro programming in VBA in the PowerPoint environment, in the example of 

creating interactive test tasks in computer science and mathematics. Such tasks can 

form the basis of designing and organizing research work of students. The first 

level quests are simple enough, the next level quests are more complex and take 

relatively more time to complete, but the next level quests require partial 

application of the results of the previous level quests. In this case, the teacher, at 

his own discretion, or taking into account the specific characteristics of the class, 

uses the features of different levels of the proposed tasks in order to activate 

teaching, divides the class into several groups with different levels of preparation, 

and Mastery may give weaker students only level 1 and level 2 tasks, and stronger 

students may give higher level tasks in addition to these tasks. Also, the teacher 

can use the "higher" level tasks as a reserve to give to the students who managed to 

complete the tasks of the previous level before the deadline. And finally, in the 

simplest version, the teacher should make it a condition for the students that the 

correct completion of the first two level tasks will guarantee a grade of "3", and the 

completion of the next level tasks will add one more point to the grade. Possible 

At the same time, the examples presented in Visual Basic for Applications are 

in some cases very unique, because even the built-in help description (Help) does 

not describe the relevant material clearly enough, so some programming methods 

were found experimentally by the authors. 

Control tests are different from audit tests. In the control tests, it is not 

reported whether the question was answered correctly or incorrectly, regardless of 

how the answer was given, it is passed to the next question, that is, it is not 

possible to return to the previously answered question. When conducting control 
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tests, i.e. at the end of the test, the number of correct and incorrect answers, the 

student's score from the control must be displayed on the screen. 

The PowerPoint program has the ability to create control tests, and actions 

such as setting buttons, determining the number of correct and incorrect questions, 

and calculating the points collected from the control are performed directly using 

Visual Basic for Application (VBA). . The control buttons included in the slide are 

implemented using the "Developer" plug-in in the Microsoft Office package. 

First of all, it is required to equip the slides for the control test 

Content of slides: 

Slide 1 is the title slide, where the "Start Test" and "Exit" buttons are placed. 

When the "Start test" button is pressed, "S", which counts the number of correct 

answers in the computer's memory, is set to zero and moves to the next slide. 

Next slides 2-11 (equal to the number of questions participating in the test, i.e. 

the test will consist of 10 questions) are entered in the title line of the test question 

and the number of answer options to the control buttons equal to the number of 

answer options. 

Slide 12 will be used to announce the test results. It contains the button "Exit" 

and "Return to the beginning of the test". 

Do the following: 

To make the Controls tab active, go to the File tab and select the Parameter 

command. Select the "Nastroit ribbon" section of the window that opens and set 

the "flag" in front of the "Developer" tab located in the right panel of the window 

and click the OK button. 

Theoretical information: 

The control buttons of the "Developer" tab are as follows

 
Today we know that many commands are automated, i.e. macrosed, used in 

application software (ADT). Students will need to know how to use macros to 

create their own automated system to deliver automated commands. 

References: 

1. Marco Fioretti lubit svobodnoe PO. Makrosy: Office automation. 

http://www.linuxformat.ru/download/189.pd 

http://www.confrencea.org/


12th-TECH-FEST-2023 
International Multidisciplinary Conference 

Hosted from Glasgow | England 
www.confrencea.org                                                                                                                                             30th December, 2023 

 
558 

2. https://www.geeksforgeeks.org/difference-between-cloud-computing-and-

fog-computing/?ref=rp 

3.https://learn.microsoft.com/ru-ru/office/vba/library-

reference/concepts/getting-started-with-vba-in-office 

4.Axmatovich J. R. In vitro rearing of trichogramma (Hymenoptera: 

Trichogrammatidae) //European science review. – 2016. – №. 9-10. – С. 11-13. 

5.Jumaev R. A. et al. The technology of rearing Braconidae in vitro in 

biolaboratory //European Science Review. – 2017. – №. 3-4. – С. 3-5. 

6.Жумаев Р. А. Массовое размножение трихограммы на яйцах 

хлопковой совки в условиях биолаборатории и ее применение в 

агробиоценозах //Халқаро илмий-амалий конфренция “Ўзбекистон мева-

сабзавот маҳсулотларининг устунлиги” мақолалар тўплами. Тошкент. – 2016. 

– С. 193-196. 

7.Жумаев Р. А. Значение представителей семейства BRACONIDAE в 

регулировании численности совок в агробиоценозах //ЎзМУ Хабарлари. – 

2017. – Т. 3. – №. 1. 

8.Жумаев Р. А. РАЗМНОЖЕНИЯ ИН ВИТРО BACON HABETOR SAY 

И BRACON GREЕNI ASHMEAD //Актуальные проблемы современной 

науки. – 2017. – №. 3. – С. 215-218. 

9.Axmatovich J. R. In Vitro Rearing of Parasitoids (Hymenoptera: 

Trichogrammatidae and Braconidae) //Texas Journal of Agriculture and Biological 

Sciences. – 2022. – Т. 4. – С. 33-37. 

10.Suleymanov B. A., Jumaev R. A., Abduvosiqova L. A. Lepidoptera 

Found In Cabbage Agrobiocenosis The Dominant Types Of Representatives Of 

The Category Are Bioecology //The American Journal of Agriculture and 

Biomedical Engineering. – 2021. – Т. 3. – №. 06. – С. 125-134. 

 

 

http://www.confrencea.org/

